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	اختبار تحديد المستوى للحاسوب في البرنامج التأسيسي العام
GFP Computing Placement Test

	

	Introduction:
The General Foundation Programme in Sohar University offers four computing courses:
· IC3M1: Key Applications in English
· IC3M1A: Key Applications in Arabic
· IC3M2: Computing Fundamentals in English
· IC3M2A: Computing Fundamentals in Arabic

A student who newly joins the General Foundation Programme (GFP) of Sohar University needs to pass only two Computing courses according to the faculty that he/she will join and as shown in the table below:
	
	تعريـف :
يقدم قسم الحاسوب في البرنامج التأسيسي العام في جامعة صحار اربعة مواد دراسية و هي:
· تطبيقات الحاسوب باللغة الإنجليزية       IC3M1  
· تطبيقات الحاسوب باللغة العربية         IC3M1A  
· اساسيات الحاسوب باللغة الإنجليزية       IC3M2  
· اساسيات الحاسوب باللغة العربية         IC3M2A

و يجب على الطالب الملتحق في البرنامج التأسيسي العام في جامعة صحار إجتياز مادتـين فقـط من مواد الحاسوب الاربعة وكما هو موضح في الجدول الآتي :


	Student Specialty
	Computing courses required
	
	المواد المطلوب دراستها
	تخصص الطالب

	· Law
· Arts and Education (except English Study)
	IC3 M1A+ IC3 M2A
	
	IC3 M1A + IC3 M2A
	· كلية القانون .
· كلية الآداب و التربية ( عدا قسم اللغة الإنكليزية).

	· Faculty of Business
· English Study in Faculty of Arts and Education
· Faculty of Languages Study
· Faculty of Computing and Information Technology
· Faculty of Engineering
	IC3 M1 + IC3 M2
	
	IC3 M1 + IC3 M2
	· كلية إدارة  الأعمال .
· قسم اللغة الإنكليزية في كلية الآداب و التربية .
· كلية الدراسات اللغوية .
· كلية الحاسوب و تقنية المعلومات .
· كلية الهندسة .

	Note:
· At the beginning, the students will do the the first placement test which could be either IC31 or IC3M1A. Students who fail this test will study the course and they will not be given another chance in future to take any Computing placement test.

· Students who pass the first placement test with a mark of 50% will be exempted from studying the first Computing course and will be given a chance to do the next Computing course. Students who score 50% or above in the placement test of the second Computing course will be exempted from studying it.

· In order to prepare for Computing placement test, the students should refer to the details of the relevant courses indicated in the following pages. 


	
	ملاحظـات :
· يجب على الطالب في البداية أداء إختبار تحديد المستوى للمادة الأولى و التي هي إما IC3M1   أو  IC3M1A . و في حال عدم تمكن الطالب من إجتياز إختبار هذه المادة فإنه يتعين عليه دراستها ، كما إنه لن يمنح أي فرصة أخرى مستقبلا لأداء أختبار تحديد مستوى لأي مادة من مواد الحاسوب .

· وفي حال إجتياز الطالب لإختبار تحديد المستوى للمادة الأولى بدرجة 50% فإنه سيعفى من دراستها و يمنح فرصة أداء إختبار تحديد المستوى لمادة الحاسوب الثانية . و عند حصول الطالب على  درجة 50% أو أكثر في إختبار تحديد المستوى لمادة الحاسوب الثانية فإنه سيتم إعفائه من دراستها أيضا .


· و لغرض التحضير لإختبارات تحديد المستوى فإنه يتوجب على الطالب مراجعة تفاصيل مادتي الحاسوب المطلوب منه دراستهما حسب تخصصه و المبينة في الصفحات التالية .  





	GFP Computing Placement Test

	

	Corse Code:
	IC3M1

	Course Name:
	Key Applications

	Pass Mark:
	50%

	Involved Students
	IC3M1 is the first Computing course in GFP for students who are going to study:
· Business
· Computing and Information Technology
· English Study in Faculty of Arts and Education
· Engineering
· Languages Studies

	Course Learning Outcomes:

	On successful completion of this course, students will be able to:

	1. 
	Identify the main components of the personal computer system in terms of hardware and software.

	2. 
	Explain the different types of Microsoft Office applications; Word, Excel and PowerPoint and identify their common features, e.g., tabs, groups, menus, quick access toolbar, tell me feature, help function, display, and hide the ribbon.

	3. 
	Identify how to create new, open, modify, navigate, save, and close a Word document, Excel sheet and PowerPoint presentation and how to convert written text into a formatted electronic document (PDF).

	4. 
	Illustrate the different text formats, e.g. bold, italic, font type, size and color; cases, subscript, superscript; etc.

	5. 
	Identify the main components of a spreadsheet window and demonstrate how to manipulate and format data and insert/delete row/column and modify their size, demonstrate how to insert, delete, rename, move, or copy, use page layout options, and print a worksheet.

	6. 
	Identify the main components of a presentation window, demonstrate the ability to insert, duplicate, delete, and move slides, identify the different design layouts and presentation view modes, and explain the difference between master slide and other slides.

	7. 
	Explore the use of the copy, cut, paste, format painter functions and the use of find, and replace commands.

	8. 
	Analyze data using various charts and explore the available analysis options and use sort and filter options.

	9. 
	Discover the use of themes and background, transition, and animation effects in presentations.

	10. 
	Apply paragraph formats e.g., in Microsoft Word and use alignment options, paragraph spacing and line spacing in a document, and identify different types of bullets/numbering.

	11. 
	Apply page setup options; page orientation, page sizes, page margins, page borders, and understand how to insert header/footer, date/time, page number, and how to print a document.

	12. 
	Employ the use footnote/ endnotes, citation and demonstrate the use of automatic spell/grammar checking & correction.

	13. 
	Use Insert options to add picture and table and explain the terms associated with them.

	14. 
	Generate various formulas using built-in functions and use them appropriately and correctly to solve problems.

	15. 
	Show the ability to insert pictures, objects, links, notes, header and footer, updated dates, and automatic numbering to enhance the look of the presentation.

	16. 
	Illustrate the ability to run/end the slide show and use various print options to print the presentation slides.




	


	IC3M1 Course Materials:



Introduction to Office applications
· Microsoft Office enables you to get essential skills to produce professional work.

	Word
	A word processor application for writing documents like letters and reports. A word file called a document and consisted of pages.

	Excel
	A spreadsheet application for performing numerical analysis. An Excel file called a workbook or book and consists of sheets.

	PowerPoint
	An application used for creating slide presentations and slide show. A PowerPoint file called a presentation and consisted of slides.



Understanding the Office Interfaces
· Each Office application has the same basic controls.

[image: ]
[bookmark: _Toc505699548][bookmark: _Toc505699659][bookmark: _Toc505941841][bookmark: _Toc507015066]
Creating, Saving, Opening, and Closing Files
· To create a new blank file in any of Office applications, you can use:
· File tab click New and then select the preferred option
· To save a file: 
· Click File tab, then choose Save or Save as, as required
· To open an existing file:
· Use File tab, and then click Open
· To close a file while keeping the application open:
· Use File tab, and then click Close
· To completely close the application, you can use below method:
· Click Exit button  [image: ]
Getting to know Microsoft Word
· Microsoft Word enables users to edit and manipulate text, format documents, insert pictures and tables, and correct spelling and grammar errors.
· You can use the keyboard to edit and enter text to any of Microsoft Office applications. 

Applying Text Formatting and Alignment
· Text formatting is a text that has a special appearance in print or on screen.
· There are many options for adjusting text, including font, size, color and text styles like Bold, Italic, and Underline.
· To apply text formatting, under Home tab, use the available tools in Font group.
[image: ]

· Word automatically aligns text to the left margin in new documents. However, you can adjust text alignment using the Left, Right, Center or Justify options.
· You can select alignment options using alignment options on the Home tab, Paragraph group.
[bookmark: _Toc505699561][bookmark: _Toc505699672][bookmark: _Toc505941854][bookmark: _Toc507015080][image: ]


Creating Bulleted and Numbered List
· Bullets and Numbering lists are ways used to outline and arrange text.
· You can apply a list style to text using Home tab, Paragraph group, click the drop-down arrow for the preferred list button.
[image: ]
[bookmark: _Toc507015084]Working with Paragraphs
· You can format your paragraphs in Word by applying Line or paragraph spacing.
· Line spacing is a space provided between lines in the paragraph.
· Paragraph spacing is a space provided between paragraphs.
· To apply line or paragraph spacing, use the below method:
· [bookmark: _Toc505699569][bookmark: _Toc505699680][bookmark: _Toc505941864][bookmark: _Toc507015091]In Paragraph group, on Home tab, click Line and Paragraph Spacing dropdown list and click Line Spacing Options for more options.
Changing Page Setup
· Word provides different page layout and formatting options. 
· You can customize the page margins, page orientation, and paper size, using the appropriate option on Layout tab, in the Page Setup group.
Working with Pictures
· You can add pictures to your document from different sources and with different formats.
· To add a picture to your document, click Pictures in Illustration group on the Insert tab.
· [bookmark: _Toc505699581][bookmark: _Toc505699692][bookmark: _Toc505941877][bookmark: _Toc507015104]When picture inserted, Format tab will appear below Picture Tools ribbon with different options to manipulate the inserted picture like changing picture styles, wrapping text options, cropping and rotating pictures.
Working with Tables
· Tables arranged in rows and columns.
· To add a table, under Insert tab, use Insert Table command in the Tables group.


Getting to know Microsoft Excel
· Excel is a spreadsheet application used to organize, analyze and store information.
· Excel’s worksheet consists of multiple columns and rows. 
· Excel uses letters (A, B, C) to identify columns and numbers (1, 2, 3) to identify rows.
· In Excel, cell is the intersection between a column and a row is called a that is identified by a cell address (cell reference) that is composed of a column letter and row number like (A1)
· Multiple cells form a cell range like (A1:C1)
· You can enter three types of data in Excel’s worksheets, labels, values or formulas.
Managing Worksheets
· You can modify columns and rows by changing column width or row height using Format options on Home tab, in the Cells group.
· To add or delete columns, rows, cells, or sheets you can use the appropriate option in the Cells group, under Home tab.
Formatting Numbers
· You can format numbers in Excel’ with different formats like currency, percentage or dates.
· To format cells as numbers, use Number group under Home tab.
[bookmark: _Toc507015138]Creating Simple Formulas
· Excel has the ability to perform mathematical calculations using formulas.
· Each formula starts with equal sign (=).
· [bookmark: _Toc505699610][bookmark: _Toc505699721][bookmark: _Toc505941910][bookmark: _Toc507015139]Formulas may contain numerical values, cell addresses or both.
Using Common Built-In Functions
· A function is a named math operation, such as AVERAGE, SUM, or COUNT.
[bookmark: _Toc507015144][image: ]
[bookmark: _Toc505699627][bookmark: _Toc505699738][bookmark: _Toc505941930][bookmark: _Toc507015156]Getting to Know Microsoft PowerPoint
· [bookmark: _Toc505699630][bookmark: _Toc505699741][bookmark: _Toc505941933][bookmark: _Toc507015159]PowerPoint is a presentation application that enables you to create presentation with different contents like videos, images, animation, Transition, different themes and much more.
Managing and Formatting Slides
· You can manage presentations by adding more slides and changing slide layouts.
· To add a new slide or changing slide layout, select the proper command in the Slides group, under Home tab,
· You can change your presentation theme by selecting the proper theme on the Design tab, Themes group.
· You can animate objects on your slides by selecting the proper animation on the Animations tab, Animation group.
· You can apply transition to your slides while moving around slides using Transitions tab, Transition to This Slide group.
· You can add hyperlinks for your slides using Hyperlink command, in the Links group, under the Insert tab.
· To run your slide show, use the proper option on Slide Show group, in Start Slide Show group.


Review Questions:
Q1: Which tab in Office Applications can be used to create new, open and save files?
Insert
View
File
Home

Q2: Complete the sentences below with the correct answers.
· [bookmark: _GoBack]a. To add an image to your document, you can use  group in  tab.
· b. Tables consist of  and  .

Q3: Match each command with its correct keyboard shortcut.
	Close a file 
	

	Print a document
	



Q4: According to the below setting, how many decimal places will be applied for the selected numbers?
 
[image: ]
Select one:
1
4
3
2

Q5: Which tab could be used to change the effect of animated objects in your presentation?
Insert tab
View tab
Animations tab
Transitions tab
[image: ]Appendix – Keyboard Shortcuts 


	GFP Computing Placement Test

	

	Corse Code:
	IC3M2

	Course Name:
	Computing Fundamentals

	Pass Mark:
	50%

	Involved Students
	IC3M2 is the second and last course of Computing study in GFP for students who are going to study:
· Business
· Computing and Information Technology
· English Study in Faculty of Arts and Education
· Engineering
· Languages Study 
if they already passed IC3M1 placement test with a score of 50% or above.

	Course Learning Outcomes:

	On successful completion of this course, students will be able to:

	1. 
	Compare the different types of computers and their purposes.

	2. 
	Describe the function of different hardware components such as CPU, storage systems, RAM, ROM etc. and common input and output devices and describe how they work in sequence to process information.

	3. 
	Identify and explain the different types of software: operating systems, application software and programming software and explain the terms shareware, freeware, end-user license agreement and the concept of software copyright.

	4. 
	Identify the basic knowledge of computer ergonomics (seating, lighting, positioning, ventilation etc.) and explain the common health problems associated with computer usage and ways to avoid them.

	5. 
	Identify the Omani data protection legislation.

	6. 
	Explore network fundamentals, types and the benefits and risk of network.

	7. 
	Evaluate the effect of IT on our lives and on society generally and explain how to get protected from network issues, viruses, and hackers etc.

	8. 
	Explore the requirements of a computer suitable for purchasing for student usage.

	9. 
	Illustrate the terms Hertz and byte.

	10. 
	Show how to install and uninstall software.

	11. 
	Illustrate the hierarchical structure of drives, files and folders and identify the meaning of file extension.

	12. 
	Use Windows operating system to manage files and folders easily by creating, deleting, and copying, moving, and compressing / decompressing files and using Settings’ options.

	13. 
	Use web browsers to browse information over the internet and deal with their tools and options.

	14. 
	Show how electronic mail works including the components of electronic mail message, electronic mail address, and electronic mail options.

	15. 
	Employ the basics of computer maintenance skills such as formatting of removable media, backup data, using good passwords, and logging on and off a computer.

	


	IC3M2 Course Materials:



Identifying computers
· Computer is an electronic device used for processing data that it receives from users and then produce the result or output.
· There are different types of computers like desktop, laptops, tablets, smartphones, e-readers, and servers.

Computer’s components
· Computers consists of hardware and software:
· Hardware are physical components that you can see and touch
· Software are operating systems, and other programs

Computer’s hardware
· Hardware are divided into, input devices, output devices and internal parts:
· Input devices send information to the computer (Example: keyboard and mouse)
· Output devices view information from the computer (Example: monitor, printer)
· Internal parts are housed within the computer case (Example: motherboard, ROM, RAM, CPU, storage devices)

Computer’s software
· Software contains a set of instruction or programs to control the computer to perform a task.
· You can install software from CD/DVD, hard drive, USB drive or download it from the internet.
· Software includes operating systems, programming software and application software:
· Operating system controls computer’s operations (Examples: Windows, MacOS, Linux, Android)
· Programming software used to develop other software.
· Application software used to perform specific function or task like word processors, spreadsheets, presentations, databases, or media software.
· Software is available for users in different forms and licenses like freeware, shareware or commercial.
Working with Files
· Files created using different programs and the program type determine the file type.
· A file can be a document, presentation, image, video, sound etc.
· Each file is identified by an extension that identify its type (Example: .mp3 identifies an audio file)

Computer Network
· Network is a system that consists of two or more computers connected to each other for sharing information and resources.
· Internet is the global network that connects billions of computers, related devices and networks around the world.
· Web browsers like Internet Explorer and Google Chrome used to browse websites online.
· Search engines used to find information over the World Wide Web based on keywords.
· Email (Electronic Mail) is a communication method that enables you to send and receive mails or messages over internet.
· Gmail and Microsoft Outlook are the most popular webmail providers.

Review Questions:
Q1: Which of the following computers is more suitable for organizations like schools and universities?
Smartphone
Tablet
Media player
Desktop

Q2: Which of the following ports is used to connect different keyboards and mouses?
Universal Serial Bus (USB) port
Video Graphics Array (VGA) port
Ethernet port
Flash Card

Q3: Which of the following operating systems is installed on HP laptops?
Windows 10
Google Android
Apple iOS
UNIX

Q4: Which of the following is a central computer that provides services to clients on the network?
Hub
Client
Server
Switch

Q5: Which of the following is an example of antivirus software?
PowerPoint
Windows Defender
Android
Excel


     

	إختبار تحديد المستوى الحاسوب في البرنامج التأسيسي العام

	

	IC3M1A
	رمز المقرر

	التطبيقات الأساسيه
	إسم المقرر

	50%
	درجة النجاح

	الحاسوب الأساسية باللغة العربية-   IC31Aهي مادة الحاسوب الأولى في مرحلة البرنامج التأسيسي العام للطلبة الذين سيلتحقون بكلية القانون و كذلك لطلبة كلية الآداب و التربية عدا طلاب قسم اللغة الإنكليزية  .
	الطلبة المشمولون

	المخرجات التعلّميّة المستهدفة للمقرر

	عند نجاح الطالب في هذا المقرر سيكون قادرا على :

	1. يتعرف على المكونات الأساسية للحاسوب.

	2. يتعرف على أنواع مختلفة من علامات التبويب، والمجموعات، والقوائم، شريط أدوات الوصول السريع، أخبرني بما تريد القيام به، وعرض وإخفاء الشريط في معالج النصوص.

	3. يتعرف على تطبيق معالجة النصوص، والتعرف على كيفية فتح وتعديل، والتنقل، وحفظ وإغلاق ملف معالج النصوص وكيفية تحويل النص المكتوب إلى مستند إلكتروني منسق (PDF).

	4. يستخدم تنسيقات المختلفة من النص على سبيل المثال، غامق، مائل، ونوع الخط والحجم واللون، والمؤثرات الخاصة؛ منخفض، مرتفع، لون تميز الخط، الحروف كبيرة أو صغيرة.

	5. تحديد العناصر الرئيسية لإطار جدول البيانات (الاكسل). و شرح كيفية إدراج، استبدال النص والأرقام ومسح البيانات في أوراق العمل داخل الخلية و تطبيق تنسيقات ورقة العمل، بما في ذلك إدراج أو حذف الصف/العمود وتعديل حجمها، وشرح كيفية إدراج أو حذف ، إعادة تسمية، نقل أو نسخ ورقة عمل.

	6. تحديد المكونات الرئيسية لنافذة العرض التقديمية ، وإظهار القدرة على إدراج الشرائح وتكرارها وحذفها ونقلها ، وتحديد تخطيطات التصميم المختلفة وأوضاع عرض العرض التقديمي ، وشرح الفرق بين الشريحة الرئيسية والشرائح الأخرى.

	7. مقارنة وظائف النسخ والقص واللصق ورسام التنسيق واستخدام أوامر البحث والاستبدال.

	8. تحليل البيانات باستخدام مخططات متنوعة واستكشف خيار التحليل المتاح واستخدم خيارات الفرز والتصفية.

	9. اكتشاف كيفية استخدام خاصية التنسيق  والخلفية ، والانتقال ، وتأثيرات الرسوم المتحركة في العروض التقديمية.

	10.  تطبيق تنسيقات الفقرة على سبيل المثال في مايكروسوفت وورد واستخدم خيارات المحاذاة ، والحدود والتظليل ، وتباعد الفقرات وتباعد الأسطر في مستند ، وتحدد أنواعًا مختلفة من الرموز النقطية / الترقيم.

	11.  تطبيق خيارات إعداد الصفحة ؛ اتجاه الصفحة وأحجام الصفحة وهوامش الصفحة وفهم كيفية إدراج رأس / تذييل الصفحة والتاريخ / الوقت ورقم الصفحة وكيفية طباعة مستند.

	12.  توظيف استخدام الحواشي السفلية / الحواشي الختامية وشرح كيفية استخدام التدقيق الإملائي / النحوي التلقائي والتصحيح.

	13. استخدام خيارات الإدراج لإضافة صورة وجدول وشرح المصطلحات المرتبطة بهما.

	14.  توظيف مختلف الصيغ باستخدام الدالات المضمنة واستخدامها على نحو مناسب وصحيح لحل المشاكل.

	15.  إظهار القدرة على إدراج الصور والكائنات والروابط والملاحظات والرأس والتذييل والتواريخ المحدثة والترقيم التلقائي لتحسين مظهر العروض التقديمية.

	16.  توضيح القدرة على تشغيل / إنهاء عرض الشرائح واستخدام خيارات الطباعة المتنوعة لطباعة شرائح العروض التقديمية.




	مادة IC3M1A


مقدمة لميكروسوفت اوفس 2016
· مايكروسوفت اوفس 2016 تمكنك من الحصول على المهارات الأساسية لإنتاج الأعمال الفنية.

	Word
	إنشاء تطبيق معالج النصوص لكتابة المستندات مثل التقارير والرسائل.  يسمى الملف بمستند ويتكون من صفحات.

	Excel
	تطبيق جدول بيانات لإجراء تحليل عددي.  يسمى  الملف بالمصنف أو الكتاب، ويتكون من أوراق.

	PowerPoint
	تطبيق يستخدم لإنشاء عروض التقديمية  .تسمى الملف بالعرض التقديمي  وتتكون من الشرائح.



فهم واجهات الاوفس 2016
· كل تطبيق الاوفس 2016 تحتوي على نفس الضوابط الأساسية.

a. تحتوي جميع تطبيق المايكروسوفت على  تبويبات مختلفة و كل تبويب يحتوي على شريط مقسم الي مجموعات مصنفة حسب الاستخدام

إنشاء وحفظ وفتح وإغلاق الملفات 
· لإنشاء ملف فارغ جديد في أي من تطبيقات Office، يمكنك استخدام:
· علامة التبويب ملف انقر فوق جديد ثم قم بتحديد الخيار المفضل 
· لحفظ ملف:
· انقر فوق علامة التبويب ملف، ثم اختر حفظ أو حفظ باسم، كما هو مطلوب 
· لفتح ملف موجود:
· استخدم علامة التبويب ملف، ومن ثم انقر فوق فتح 
· لإغلاق ملف مع الحفاظ على فتح التطبيق:
a. استخدم علامة التبويب ملف ومن ثم انقر فوق إغلاق 
· لإغلاق التطبيق تماما، يمكنك استخدام أدناه الأسلوب:
· انقر  على ايقونة اغلاق  [image: ]

ورد 2016
· تمكن مايكروسوفت وورد المستخدمين من تحرير , وتعديل النصوص  و ادراج اشكل و صور,  إدراج والجداول، وتصحيح الأخطاء الإملائية والنحوية.
·  يمكنك استخدام لوحة المفاتيح لتعديل وإدخال نص في أي من تطبيقات المايكروسوفت 

تنسيق النص والمحاذاة 

· تنسيق النص وهو نص له مظهر خاص في شكل مطبوع أو على الشاشة.
· هناك العديد من الخيارات لضبط النص، بما في ذلك أنماط الخط والألوان وحجم النص، مثل غامق ومائل وتسطير.
· لتطبيق تنسيق النص، ضمن علامة التبويب الصفحة الرئيسية، استخدم الأدوات المتاحة في المجموعة خط
[image: ]

· الورد يقوم تلقائياً بمحاذاة النص إلى الهامش الايمن في المستندات الجديدة. ومع ذلك، يمكنك ضبط محاذاة النص باستخدام الخيارات الموجودة إلى اليسار أو اليمين، ومركز أو ضبط.
· يمكنك تحديد خيارات المحاذاة باستخدام خيارات المحاذاة في علامة التبويب الصفحة الرئيسية، في المجموعة فقرة.
[image: ]
إنشاء قائمة ذات تعداد نقطي وتعداد رقمي 
· تعداد نقطي وتعداد رقمي قوائم هي الطرق المستخدمة لتحديد وترتيب النص.
· يمكنك تطبيق نمط قائمة على النص باستخدام التبويب الصفحة الرئيسية، في المجموعة فقرة، انقر فوق سهم القائمة المنسدلة للزر قائمة المفضلة.
[image: ]
مجموعة الفقرة 
· يمكنك تنسيق الفقرات في الورد  بتطبيق تباعد سطر أو فقرة.
· تباعد الأسطر مسافة بين الأسطر في الفقرة.
· تباعد الفقرة مسافة بين الفقرات.
· لتطبيق تباعد سطر أو فقرة، استخدم الأسلوب ادناه:
في المجموعة فقرة، من علامة التبويب الصفحة الرئيسية، انقر فوق تباعد الأسطر والفقرات من القائمة المنسدلة وانقر فوق "خيارات تباعد الأسطر" لمزيد من الخيارات.
تغير تنسيق الصفحة
· يوفر  الورد تنسيق وتخطيط صفحة مختلف الخيارات.
· يمكنك تخصيص صفحة الهوامش واتجاه الصفحة، وحجم الورق، استخدام الخيار المناسب من علامة التبويب تخطيط، في المجموعة إعداد الصفحة.

ادراج الصور
· يمكنك إضافة الصور إلى المستند الخاص بك من مصادر مختلفة وبأشكال مختلفة.
· لإضافة صورة إلى المستند الخاص بك، انقر فوق الصور في الرسم التوضيحي مجموعة ضمن علامة التبويب إدراج.
· عند إدراج صورة، سوف تظهر علامة التبويب تنسيق أسفل "أدوات الصورة" الشريط مع مختلف 
خيارات التعامل مع الصورة التي تم إدراجها مثل تغيير أنماط الصورة، التفاف النص خيارات ،قص الصورة، دوران الصور.

ادراج الجداول
· الجداول مرتبة في صفوف وأعمدة.
· لإضافة جدول، ضمن علامة التبويب إدراج، استخدام الأمر "إدراج جدول" في المجموعة جداول.اكسل 2016
· الاكسل تطبيق جدول بيانات المستخدمة لتنظيم وتحليل وتخزين المعلومات.
· ورقة عمل في اكسل يتكون من عدة أعمدة وصفوف.
· يستخدم اكسل أحرف (A,B,C) لتحديد الاعمدة و  أرقام (1، 2، 3) لتحديد الصفوف.
· ، تسمى نقطة التقاطع بين عمود وصف بالخلية
· عنوان خلية (مرجع الخلية) التي تتألف من عدد الصفوف وحرف العمود مثل (A1)
· خلايا متعددة تشكل نطاق من خلايا مثل (A1:C1)
· يمكنك إدخال ثلاثة أنواع من البيانات في أوراق العمل في Excel، والتسميات، والقيم أو الصيغ.
ورقة العمل
· يمكنك تعديل الأعمدة والصفوف بواسطة تغيير ارتفاع الصف أو عرض العمود باستخدام خيارات التنسيق من علامة التبويب الصفحة الرئيسية، في المجموعة خلايا.
· لإضافة أو حذف أعمدة أو صفوف، والخلايا أو أوراق يمكنك استخدام الخيار المناسب في المجموعة خلايا، ضمن علامة التبويب الصفحة الرئيسية.
تنسيق الارقام
· يمكنك تنسيق الأرقام في Excel ' مع تنسيقات مختلفة مثل العملة أو النسبة المئوية أو التواريخ.
· لتنسيق الخلايا كأرقام، استخدم المجموعة رقم ضمن علامة التبويب الصفحة الرئيسية.
انشاء دوال رياضية بسيطة
· يحتوي Excel على القدرة على القيام بالعمليات الحسابية باستخدام الصيغ.
· ويبدأ كل صيغة بعلامة المساواة (=).
· قد تحتوي على الصيغ القيم العددية، عناوين الخلية أو كليهما.


استخدام الدوال المخزنة بالاكسل
· [image: ]الدالة هي  عملية رياضيات ، مثل AVERAGE، SUM أوCOUNT.

البوربوينت 2016
· PowerPoint هو تطبيق العرض تقديمي التي تمكنك من إنشاء عرض تقديمي مع محتويات مختلفة مثل أشرطة الفيديو، والصور والرسوم المتحركة، والانتقال، مواضيع مختلفة وأكثر بكثير.
إدارة وتنسيق الشرائح 
· يمكن إدارة العروض التقديمية بإضافة المزيد من الشرائح وتغيير تخطيطات الشرائح.
· لإضافة شريحة جديدة أو تغيير تخطيط الشريحة، حدد الأمر المناسب في مجموعة الشرائح، ضمن علامة التبويب الصفحة الرئيسية،
· يمكنك تغيير موضوع العرض التقديمي الخاص بك باختيار الموضوع المناسب ضمن علامة التبويب تصميم، في المجموعة تنسيق.
· يمكنك تحريك كائنات على الشرائح الخاصة بك عن طريق اختيار الحركة المناسبة في علامة التبويب حركات، في المجموعة الحركة.
· يمكنك تطبيق الانتقال إلى الشرائح الخاصة بك بينما يتحرك الشرائح باستخدام التبويب انتقالات، المجموعة نقل إلى "هذه الشريحة".
· يمكنك إضافة ارتباطات تشعبية للشرائح الخاصة بك باستخدام الأمر ارتباط تشعبي في المجموعة ارتباطات، ضمن علامة التبويب إدراج.
· لتشغيل عرض الشرائح الخاص بك، استخدم الخيار المناسب في مجموعة الشرائح، في المجموعة "بدء عرض الشرائح


	اختصارات لوحة المفاتيح


[image: ]

أسئلة المراجعه:
السؤال الأول: ماذا يسمى ملف الوورد؟
مستند
ورقة عمل
شريحة
عرض تقديمي
 
السؤال الثاني: ما هو اختصار لوحة المفاتيح المستخدم لطباعة ملف؟
Ctrl + S
Ctrl + P
Ctrl + F
Ctrl + R

السؤال الثالث: أي مما يلي يعتبر نوع من أنواع المحاذاة؟
مفرد
مزدوج
أفقي
توسيط

السؤال الرابع: ما هو التبويب المستخدم لفرز البيانات في برنامج الإكسل؟
مراجعة
إدراج
بيانات
ملف

السؤال الخامس: ما هو التبويب المناسب لإضافة تأثيرات حركية لعناصر الشريحة؟
حركات
تنقلات
الصفحة الرئيسية
ملف




	إختبار تحديد المستوى للحاسوب في البرنامج التأسيسي العام

	

	IC3M2A
	رمز المقرر

	أساسيات الحاسوب
	إسم المقرر

	50%
	درجة النجاح

	مادة التطبيقات الأساسية باللغة العربية -  IC3M2Aهي مادة الحاسوب الثانية و الأخيرة في مرحلة البرنامج التأسيسي العام لطلبة تخصص القانون  ,و كذلك طلبة تخصص كلية الآداب و التربية ( عدا طلاب قسم اللغة الإنكليزية ) و اللذين إجتازوا مادة الحاسوب الأساسية (IC3M1A) بنجاح و بدرجة 50% أو أكثر .
	الطلبة المشمولون

	المخرجات التعلّميّة المستهدفة للمقرر

	عند نجاح الطالب في هذا المقرر سيكون قادرا على :

	1. يصنف أنواع مختلفة من أجهزة الحاسوب واستخداماتها.

	2. يصف مكونات الأجهزة المختلفة من أجهزة الحاسوب الشخصية مثل (الأجهزة الطرفية، ذاكرة القراءة، وذاكرة الوصول العشوائي، والتخزين) وكيفية عملها.

	3. يميز التعريف الخاص بالبرمجيات وأنواعها (نظم التشغيل والبرمجيات التطبيقية وبرمجيات البرمجة) والتعرف على انواع مختلفة من التراخيص (النسخة التجريبية، مجانية، اتفاقية ترخيص المستخدم النهائي).

	4. يتعرف على كيفية التعامل مع الحاسوب داخل بيئة العمل وتحديد المشاكل الصحية الشائعة عند استخدام جهاز الحاسوب وكيفية توفير بيئة صحية.

	5. التعرف على القانون العماني والتشريعات لحماية البيانات.

	6. يتعرف على معنى الشبكة والإنترنت، وتحديد الانواع المختلفة من شبكات الاتصال.

	7. يناقش الآثار المترتبة على استخدام تكنولوجيا المعلومات في الحياة الاجتماعية، يتعرف على القضايا التي تختص بالشبكة وكيفية حماية الشبكة من الاختراقات والفيروسات.

	8. تقييم الاحتياجات اللازمة لشراء جهاز حاسوب مناسب.

	9. يستخدم وحدات القياس المختلفة (بايت والهيرتز)

	10. تثبيت وإلغاء تثبيت البرامج.

	11. يشرح الهيكل الهرمي لمحركات الأقراص، الملفات والمجلدات، وفهم معنى ملحق الملف.

	12. يستخدم Windows 10 لإدارة الملفات والمجلدات بسهولة عن طريق إنشاء وحذف ونسخ، نقل وضغط/إلغاء ضغط الملفات.

	13. يستخدم متصفحات الانترنت لتصفح المعلومات عبر الإنترنت، والتعامل مع الأدوات والخيارات الخاصة بها.

	14. يستخدم Office 365 Outlook لإرسال وتلقى رسائل البريد الإلكتروني واستخدام الخيارات: الرد، إعادة التوجه، نسخة والنسخة المخفية.

	15. توظيف مهارات صيانة الحاسوب مثل تهيئة الوسائط القابلة للإزالة، النسخ الاحتياطي للبيانات، واستخدام كلمات مرور جيدة، وتسجيل وإيقاف تشغيل حاسوب.




	تحميل فصول مادة IC3M2A


تحديد أجهزة الحاسوب
 الكمبيوتر هو جهاز إلكتروني يستخدم لتجهيز البيانات التي يتلقاها من المستخدمين وثم تنتج نتيجة أو الإخراج.
  وهناك أنواع مختلفة من أجهزة الكمبيوتر مثل سطح المكتب وأجهزة الكمبيوتر المحمولة،  والهواتف الذكية، وخوادم.
 
مكونات جهاز الحاسوب
  وتتكون أجهزة الكمبيوتر من الأجهزة والبرامج:
 الأجهزة هي المكونات المادية التي يمكن أن تشاهد وتعمل باللمس
 هي برامج أنظمة التشغيل، وبرامج أخرى
 
جهاز الحاسوب
  تنقسم الأجهزة بالحاسوب الي أجهزة الإدخال والإخراج و المكونات الداخلية
 أجهزة الإدخال  تقوم بإرسال المعلومات إلى الكمبيوتر (مثال: لوحة المفاتيح والماوس)
 إخراج أجهزة تقوم بعرض المعلومات من الكمبيوتر (مثال: جهاز العرض، الطابعة)
 يسكن الأجزاء الداخلية داخل الكمبيوتر (مثال: اللوحة، مدمج، وذاكرة الوصول العشوائي، وحدة المعالجة المركزية وأجهزة التخزين)

برامج للحاسوب
  يحتوي البرنامج على مجموعة من التعليمات أو برامج التحكم في الكمبيوتر لتنفيذ مهمة.
  يمكنك تثبيت البرامج من الاقراص المدمجة، القرص الصلب، محرك أقراص USB أو تنزيله من الإنترنت.
  وتشمل البرامج أنظمة التشغيل، برمجة البرمجيات وتطبيق البرمجيات:
 نظام التشغيل مراقبة عمليات الكمبيوتر (أمثلة: ويندوز، ماك، لينكس)
 برمجة البرمجيات المستخدمة في تطوير البرامج الأخرى.
 تطبيق البرمجيات المستخدمة لأداء وظيفة محددة أو مهمة مثل معالجات النصوص وجداول البيانات والعروض، وقواعد البيانات، أو برامج وسائل الإعلام-
  البرنامج متوفر للمستخدمين في أشكال مختلفة التراخيص مثل البرامج المجانية، البرامج المتاحة للمستخدم لفترة ومنية محددة و البرامج التجارية .

العمل مع الملفات
  الملفات التي تم إنشاؤها باستخدام برامج مختلفة ونوع البرنامج تحديد نوع الملف.
  قد يكون ملف مستند، عرض تقديمي، الصورة، الفيديو، الصوت إلخ.
  يتم تعريف كل ملف بملحق تحديد نوعه (مثال: mp3. يحدد ملف صوتي)
 
شبكة الحاسوب
  الشبكة هو نظام يتكون من اثنين أو أكثر من أجهزة الكمبيوتر متصلة ببعضها البعض لتبادل المعلومات والموارد.
  إنترنت، الشبكة العالمية التي تربط المليارات من أجهزة الكمبيوتر والأجهزة ذات الصلة والشبكات في جميع أنحاء العالم.
  تستخدم مستعرضات ويب مثل Internet Explorer وجوجل كروم لتصفح المواقع على الإنترنت.
  تستخدم للبحث عن المعلومات على شبكة ويب العالمية استناداً إلى الكلمات الأساسية محركات البحث.
  البريد الإلكتروني (البريد الإلكتروني) هو وسيلة اتصال التي تمكنك من إرسال وتلقى الرسائل أو الرسائل عبر الإنترنت.
   البريد الإلكتروني من شركة جوجل و Microsoft Outlook الأكثر شعبية.


أسئلة المراجعه:
السؤال الأول: ماذا يطلق على مكونات الحاسوب المتصلة عبر المنافذ والكابلات؟
اختر أحد الخيارات
المكونات الداخلية
البرمجيات
الأجهزة الطرفية
أنظمة التشغيل
 
السؤال الثاني: أي مما يلي يعتبر نوع من أنواع الطابعات؟
اختر أحد الخيارات
الطابعة النفاثة للحبر
لوحة اللمس
الماسحة الضوئية
كرة التتبع

السؤال الثالث: أي من الوحدات التالية تساوي مليون بايت؟
جيجابايت
كيلوبايت
بت
ميجابايت

السؤال الرابع: ماذا يطلق على النظام الذي يتكون من جهازي حاسوب أو أكثر متصلين ببعضهما البعض لتبادل المعلومات والموارد ؟
اختر أحد الخيارات
البرمجيات
الأجهزة الصلبة
الشبكة
التخزين

السؤال الخامس: ما هو أنسب جهاز حاسوب للطلاب؟
اختر أحد الخيارات
الحاسوب اللوحي
الهاتف الذكي
مشغل أصوات
الحاسوب المحمول


References - المصادر:
Wempen, F., Hattersley, R., Millett, R., & Shoup, K. (2015). Computing Fundamentals: Introduction to Computers. Indiana: Jone Wiley & Sons, Inc., Indianapolis.
Weverka, P. (2015). Office 2016 All-In-One For Dummies. For Dummies.
Marguerite Caunt, K. H. (2009). IC3 INTERNET AND COMPUTING CORE CERTIFICATE GUIDE. Pitt Meadows: CCI Learning Solutions Inc.
Morrison, C., Wells, D., & Ruffolo, L. (2015). Computer Literacy: A Comprehensive Guide to IC3. Stamford: Cengage Learning.
Sue Wong, I. H. (2012). IC3 Computing Fundamentals Global Standard 4. CCI Learning Solutions.

 Recommended online Sources for IC3M1 – مصادر الإنترنت إضافية: 
https://edu.gcfglobal.org/en/topics/office2016/
https://support.office.com/en-us/office-training-center?ms.officeurl=training 

Recommended online Sources for IC3M2 - مصادر الإنترنت إضافية: 
https://edu.gcfglobal.org/en/topics/computers/
https://www.tutorialspoint.com/computer_fundamentals/index.htm
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